
Workina with WInERMS 

Starting W1nERMS 

Once installation is complete you can start WII1ERMS by double-clicking the WinERMS icon in 
the Program Manager. 	 - 

Using the sample WinERMS database 

To use the sample W1nERMS database, follow the instructions provided in the enclosed 
tutorials. 

Using other existingERMS databases with WinERMS 

You can use any of your existing ERMS databases with WinERMS. This section describes 
how to use an existing database in WinERMS. 

To use an ERMS database with WinERMS 	 r 

Run WInERMS, and choose Open flatabase from the File menu, and then click on the ZW 
button in the dialog box. 

In the AREA.IND box type the path to the directory containing the database, or press the 
Browse button and look for the AREA.INO file in the database directory. 

Choose the OK button, to add the database to the list of databases available in WInERMS. 

Choose Open Database from the File menu, and select the database from the list of 

databases. 

Choose the OK button, and now build a map with the new database. 

Configuring Windows for W1nERMS 

Choosing optimal display settings 

Display and memory settings in Windows affect how WinERMS performs. In general the 
greater the number of colours supported by the display device, and the larger the number of 
pixels, the slower VY1nERMS (and Windows in general) will run. Maps produced using more 
colours and pixels will, however, look better. The table below lists the most common colour 
and pixel resolution options. 	 - 

Fastest 	 Slowest (Best 
Pure Colours 16 	 256 	 64K 

Renlution 	640x480 	800x600 	1024x760 

The standard VGA display has a resolution of 640x480 pixels and can display 16 pure colours. 
It simulates other colours by dithering or mixinj the pure colours. This is the fastest display 
with a map resolution very similar to the DOS ERMS program. 

As a good compromise between speed and map appearance we recommend using 256 
colours with a resolution of 800x600 on a 486 processor computer, or 640x480 on a 386 
processor computer. Please note that some display adaptors cannot support these colours or 
resolutions, please check with your hardware supplier. 



Using WinERMS Help 
WInERMS comes with Help, an online reference tool, that includes step-by-step procedures 
that you can follow as you work, and reference information about using WinERMS commands. 

What's In Help? 
You can view the WinERMS Help Contents window by choosing Contents from the Help 
menu. From this window you can lump" to more specific information. Click on the underlined 
text in the window to jump to the help topic. 

Getting Started 	Click to view a general introduction to WInERMS. 

Mapping 	 Click to see comprehensive information about creating maps. 

Command Reference Click to see a list of WinERMS commands. 
ERMS Data Types 	Click to see details of the data types supported by 

WinERMS. 

Getting Help 
You can get help in several ways. For example, you can choose the help button in any dialog 
to get context-sensitive help. Pressing the Fl function key will also display context-sensitive 
help. You can even get help about how to use the Help system. Choose Contents from the 
Help window. Then, in the Help window, choose I-low To Use Help from the Help menu. 

Searching for Help 
The fastest way to get Help on a topic is to use the search feature. To open the Search dialog 
box choose Search from the Help menu, or click on the Search button in the Help window. 



W1nERMS TUTORIALS 

Introduction 

The aim of the WinERMS tutorials is to provide an introduction to the WinERMS GIS mapping 
environment. The tutorials are designed to be used in conjunction with the Windows and 
WinERMS on-line Help. The tutorials start out with a step-by-step description of how to produce, 
view and save a simple map. As the tutorials progress the user is introduced to more complicated 
WinERMS functions, such as Boolean overlaying. The user is encouraged to experiment with the 
options available throughout the mapping process in order to gain an appreciation of the 
functionality and flexibility of WinERMS. The tutorials are based on the WInERMS demonstration 
database which is a series of selected map layers from the Northeast Forests Biodiversity Study 
(NEFBS). A number of grid-cell layers (eg elevation and solar radiation index) and line layers (eg 
the study area boundary, roads and watercourses) are provided. You will also be introduced to 
new types of WinERMS map layers, ie. polygons, vectors and points. 

Working with Microsoft Windows 

Before you start.the WinERMS Tutorials, you should know how to use.Microsoft Windows, 
including how to do the following: 
• Use Program Manager and File Manager. 
• Use the mouse (click, double-click, and drag). 
• Move around in a window and use the scroll bars. 
• Move, resize, and close a window. 

 

• Choose commands from menus and select options in dialogue boxes. 
• Locate, open, copy and delete files. 

Refer to your Microsoft Windows User's Euide for more information on any of these 

techniques. 

WThERMS Tutorial Outline 

• Tutorial 1: Creating a WinERMS Map. A step-by-step guide to producing a simple map and an 
introduction to the basic functions of WinERMS. 

• Tutorial 2: Advanced colour control and map layout, introduces advanced colour control 
including colour ramping, the use of default and user defined palettes, duplicating a map view 
and displaying more than one map at a time. 

• Tutorial 3: Using the new WInERMS data types including display and linkage to a DBMS. 
• Tutorial 4: Enhanced Boolean overlaying in WinERMS. A two part tutorial describing the new 

functionality. 
• Tutorial 5:' Printing a map from W1nERMS. A step by step guide to producing a hardcopy map. 



Tutorial 1: Creating a WInERMS Map. 

Tutorial 1 describes steps for the production of a simple map and introduces some of the basic 
functions of WInERMS, including colour selection and zooming a map view. 

Open W1nERMS 

Type win at the command line and Double-click on the WinERMS icon in the WInERMS 
program group in the Windows Program Manager window. 

Open the W1nERMS Sample Database 

Select Open Database from the Ede menu. 

Choose the North East Fprests (WInERMS Demo) sample database (double-click on the 
database name or click on OK). 

When you first install W1nERMS only the supplied sample database is displayed in the 
Databases list. However, by using Add Database from the Eile menu, other existing 
databases can be added to the list, including any existing DOS E-RMS databases residing 
on your machine. W1nERMS allows simultaneous access to multiple databases. Maps 
from two or more databases can be displayed and manipulated on the screen at the same 
time. 

Create a W1nERMS Map 

Select New Map from the Map menu. 

You may also create a new map by choosing the New Map button on the toolbar, or by 
holding down the right mouse button and selecting New Map from the Quick Menu. 

In all cases, a dialog window titled Map Specification appears, which allows you to specify 
the map contents. Choose a tab panel of controls for the layers or options you wish to set 
or change. For example: selecting the Base tab panel will display the Base Layer and 
Colour buttons, allowing you to set the contents of the map base layer and its colours. The 
Options tab panel contains controls affecting the entire map such as window positioning, 
zoom area selection and saving a user-defined variable. 

Specify a Base Layer 	 , 

In the Map Specification dialog, choose the Base tab, and select the Base Layer button 

A new dialog window titled Select BASE Layer appears (all fupctionality discussed here 
also applies to the Top Layer). All available variables are displayed in the Variables list 
The picture on the left side of a variable name indicates the variable type. The variable 
types represented are gridcell, polygon, vector, and point data types. The gridcell data type 
is present in DOS E-RMS. The polygon, vector, and point data types are new to WInERMS 
and will be discussed in Tutorial 3. 

Select a variable from the list by clicking on it. Selecting a variable will display its 
categories in the Categories list. If there are too many items to appear in the list, then a 
scrollbar is displayed on the right-hand side of the list Click the top or bottom of the 
scrollbar, or drag the indicator with the mouse to view more items in the list 

Different methods and short cuts are available for specifying base or top layer contents 
from these two list boxes. After selecting a variable you need to select which categories of 
the chosen variable are to be included in the current layer. To select all categories hold 
down the left mouse button and drag the pointer over all the categories either from top to 
bottom or bottom to top. Select OK to register your selection. A useful shortcut is to double 
click on the required variable which then automatically selects all of the variable's 



categories and registers the selection. A single category can be chosen by clicking on it 
with the left mouse button. This highlights the chosen category and selecting OK registers 
the selection. If you wish to select two or more (but not all) categories, hold down the 
Control (CtrI) key and either use the left mouse button to select individual items ordrag 
the pointer to select blocks of successive categories. When all required categories have 
been highlighted release the Ctrl key and select OK to accept the selection. 

More information about functions available in dialog windows such as this can be found by 
either pressing the Fl key or selecting flelp which will give context sensitive information on 
the available operations in the displayed dialog box. 

Under Variables, select Elevation (loom classes). 

Select all elevation categories using one of the methods described under step 5 and 
select OK to display the map. 

Altering the contents of, the Base Layer 

Position the mouse pointer over the displayed nap and hold down the right mouse 
• 	button to display a Quick Menu and select Map Contents ( do not release the mouse button 

until you have moved the highlight bar to the Edit Map item in the Quick Menu ). The Map 
Specification dialog window will be redisplayed. Make sure that the tab named Base is 
selected ( at the top of the stack) and select Base Layer. 

Note that using the Quick Menu is not the only way to redisplay the Map Speciflcation 
dialog winciow. This can eisa be achieved by either selecting specification from the Edit 
menu or by clicking on the Change View Specification button in the toolbar. 

Select Vegetation Systems (Landsat TM) and choose the two categories Moist Open 
Forest and Dry Open Forest. Remember that they can be selected by either dragging 
the mouse pointer over both of these categories as they are adjacent to each other or 
hold down the Ctrl key and individually select these two categories. 

Selept OK twice to display the modified map. 

This is a good place to learn more about the functionality of the Quick Menu. The menu is 
activated by holding down the right mouse button and highlighting a selection to perform a 
desired operation. Move the mouse pointer to some location that is not over the map or the 
legend and activate the Quick Menu by holding down the tight mouse button. Note that the 
operations available allow only the creation of a new map or the opening of an existing one 
(saved to file). Now move the mouse pointer over the displayed map and activate the 
Quick Menu. Notice that the available operations only include those that are relevant to the 
map such as editing variables or colours in either the Base or Line layers. Finally move the 
mouse pointer over the legend and activate the Quick Menu. The only operations available 
are those that relate to the legend itself such as changing the font, used and whether the 
legend is displayed or not As you have just seen the Quick Menus are context sensitive. 
They provide a quick alternative to using the menu bar at the top of the screen for carrying 
out common operations. 

Basic colour selection 

Use the Quick Menu to select flase Colour which will then display the Category 
Colour/Style dialog window. Alternatively select fiase Colour from the Colour Menu. 

Basic colour selection involves three operations. Firstly, category selection uses the same 
single or multiple selection methods as discussed under step 5. Secondly, colour 
assignment for the selected categories is accomplished by selecting one of the displayed 
colours from the Colour list box. Thirdly, the colours may be layed down using any one of 
the Eattern selections available by clicking on the, down arrow to the right of the flattern 
box which will then display a series of patterns from solid through a collection of hatched 
patterns to a set of symbols. Note that if a symbol is chosen, then another list box below 



becomes active so that the symbol point size can be set in the same way that one sets the 
point size of a selected font. 

Select the Moist Open Forest category and choose a light green colour but leave 
the pattern solid (the default). 

Now select the Dry Open Forest category and choose a red colour but this time select 
a hatched pattern from the fattern list. 

Select OK and the map will be redisplayed with the new colours and styles. 

Modify the Line Layer 

Use the Quick Menu to select Map Contents and select the Lines tab. 

Select the Line Layer button to display the Select Lines dialog window. 

From the aorder group box, select 'Map border with tick marks' and make sure that 
the 10,000m grid is selected. 

V'hnERMS supports user-sejectable spacing of tickmarks and gridlines ranging from 10m 
to 100km. 

Now modify the selection of displayed lines. Currently active lines are highlighted. To 
change this selection hold down the Ctrl key and deselect '30 Minute Grid' and select 
'Highways' and 'Major Roads'. Leave 'NEFBS Study Boundary' active. 

Select OK twice to display the updated map. 

Note that the base layer was remade much faster than in the initial display. This is because 
unchanged layerà are not rebuilt if a map view is edited but simply copied to the screen 
display. This speeds up the redisplay of maps that have only some but not all layers 
changed as a result of editing a map view. 

To make the highways and major roads more distinguishable use the Quick Menu to 
select Line Colour. Now select the highway category and choose a red colour. Then 

select the major roads category and choose a dark brown colour. Then select OK to 
redisplay the map. 

Reposition the map display window 

Try repositioning the map window on the screen by placing the mouse pointer over the 
window title bar, holding down the left mouse button and dragging the window to a 
new position. 

Resize the map display window 

The map display window may be resized by positioning the mouse pointer over any 
border or corner of the window, holding down the left mouse button and dragging in the 
direction of the arrows that popup to replace the default pointer. 

In addition to the above step, there are three default window sizes that can be invoked 
by selecting either the maximise, minimise or restore items in the map window's 	- 

menu. 

To activate the menu, point and click on the icon in the top left hand corner of the window. 
To make the window occupy the full screen, use the Maximise menu item. To make to the 
window shrink to an icon use the Minimise menu item. The Sestore item will restore the 
window to its original size. These operations can also be performed using the arrow 
buttons in the top right corner of the map window. 

Zoom in and out of the map display 

Make the map window occupy the fullscreen using the window's Maximise menu 
item. 



To choose a rectangular area that you want to zoom into, position the mouse pointer 
over one of the four corners. Now hold the left mouse button down and drag the 

mouse pointer over to the diagonally opposite corner. 

This should have drawn a box delineating the proposed zoom area. 

Use the Quick Menu (right mouse button) to select the Zoom In menu item and the 
map will be remade so that the zoom area is enlarged to fill the map window. 

The Zoom Into Map button on the toolbar can be used in place of the Zoom/n menu item. 

Repeat steps 25 and 26 to zoom in further. 

Repeat steps 25 and 26 to zoom in even further stiH. 

Using the Quick Menu, select Zoom Qut. Repeat this step to zoom out more than one 
level. 

Two things are worth noting while you do this. Firstly, unlike DOS E-RMS, zooming out in 
WInERMS takes you to the previous zoom level, not to the entire database area. 
Secondly, previous zoom levels are redisplayed veiy quickly as explained in greater detail 
below. 

Using the Quick Menu select Eull Size. The original full map should be redisplayed 
without having to rebuild any of irs component layers. 

The Zoom In/Out functionality has been implemented to optimise map refreshing in such a 
way that for each level of zoom, a 'snapshot' of the area is stored so that when backing out 
of the zoom, the redisplay occurs as fast as possible. You can also go directly from a 
deeply nested set of zoom levels to the original full area by simply choosing the Eull Size 
menu option. Note that under low memory conditions, only the ve,y bottom layer of the 
zoom is stored so that incremental zooming out will cause each interim level to be rebuilt, 
resulting in a slower redisplay 

Save the map or workspace 
Since we are at the end of Tutorial 1, this would be a good time to discuss options 
available to you in order to save your work. At this point you can either save the map that 
you produced or save the entire Workspace on your screen. The differences are as follows: 

Savingamap 

Select either save or Save as... from the Eile menu or use the tool bar Save View to 
Disk button to display a Save As winØow. 

Type in a filename without any .extension as WinERMS map view files all have a 
.WMP file extension added when they are saved. Select OK to save the map. 

Saving a workspace 

Select Save workspace from the Eile menu. 

Type in a filename without any .extension as WinERMS workspace files all have a 
.WMK file extension added when they are saved. Select OK to save the 

workspace. 

The major difference between saving a map view and saving a workspace is in the 
extent of information saved. 

When a map view is saved, only the instructions needed to reconstruct the map view 
from your selected database components, the zoom level and colour information, for the 
display components are stored. 

However, when a workspace is saved, a 'snapshot' of your LMnERMS desktop is 
saved. This includes all map views, their respective window sizes and screen 
positions plus all the information required to reconstruct exactly what was on the screen 
when you savedthe workspace. 

The four most recently saved map views or workspaces can be reloaded simply by 
selecting the desired filename from the list at the bottom of the Eile menu. 
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Tutorial 2: Advanced colour control and map layout 

Tutorial 2 introduces advanced colour control including colour ramping and the use of default 
and user defined palettes. Also discussed is the use of predefined plot windows, duplication 
of maps and disp!ay of multiple maps on the same screen. 

If you are continuing from tutorial I or have any maps on the screen, it is a good time to clear 
your workspace in preparation for this tutorial. Use the Qose command from the Eile menu for 
each map window still displayed on the screen. 

Using prede fined Plot Windows 

1, Select New Map from the Quick Menu to display the Map Specification window. 

Select the Base tab and click on Base Layer to display the Select Base Layer dialog 
window. 

Now double click on Solar Radiation to select all categories of that variable. 

Select the Options tab and click on Zoom Area... to display the Select Zoom Area dialog 
window. 

Click on the down arrow to the right of <current zoom area> to display the list of 
available zoom areas and select the item labelled 'Central Section'. 

Note that you can define your own zoom areas by typing AMG values into each of the four 
minimum/maximum Easting and Northing boxes. Also, any new zoom areas that you 
define either by typing in coordinates or by using the interactive zoom-in function may be 
saved for future use. Do this by selecting the save... button, typing in a new name for your 
zoom area and selecting OK to save it 

Select 01< twice to exit the dialog windows and display the new map. 

Default and User Defined colour palettes 

Each of the variables in the sample database has been assigned a default palette. These 
palettes are designed to provide a good selection of default colours for the categories of 
each variable. The default colours for the displayed Solar Radiation variable are shades of 
grey ramping from black to white. Any user defined palette can be saved as the default 
palette for a particular variable. This facility is enhanced by the ability to associate the 

• 	 palette with either a base layer or top la$'er. That is, you can have two separate default 
palettes for each variable, one for when the variable is chosen as a base layer and one for 
when the variable is chosen as a top layer. User defined palettes for the lines layer can 
also be saved as default palettes. 

If you define a palette for a particular variable and wish to oveiwrite the current defaults 
supplied with this variable in the sample database, then choose the save Defaults.., item 
from the Golour menu.  

Applying Colour Ramping to a variable 

Use the flase  Colour in the Quick Menu to display the Category Colour/Style dialog 
window and select fiamp  which brings up the Colour Ramping dialog box. 

Select a dark green colour for the Ztart Colour and a light green for the End Colour. 
Press OK twice to redisplay the modified map. 

Notice that the definition between categories is not vein, clear. This can be improved by 
creating a larger difference between the start and finish colours. To do this we need to alter 
the colour detail for both the start and finish colours. 



Select the.ase Colour item from the Quick Menu as before and select Eamp... 

Select the Start Colour Detail button to display the Colour Detail dialog window. Using 
the mouse pointer, drag the triangular slider gadget down towards the black end of the 
scale to create a very dark green shade. Select OK to return to the Colour Ramping 
dialog window. 

Now select the End Colour Detail button to again display the Colour Detail dialog 
window as in step 10. As before, use the mouse to drag the slider gadget up towards 
the white end of the scale to create a very light shade of green. Select OK to return to 
the Colour Ramping dialog window. 	 * 

Select OK to redisplay the updated colours for this map. 

Notice that the definition of the map has increased with the improvement in colour range. 
This could be a good time to investigate other features of the Colour Detail dialog window. 
Select Base Colour from the Quick Menu, select R8mp and then select Start Colour DetaiL 
Colours can be chosen froni the main spectrum which is the large square multicoloured 
region in the top left. By simply clicking anywhere in this box a particular colour can be 
quickly chosen. Dragging the crosshair under the mouse pointer horizontally alters the 
Hue. Dragging the crossh air vertically alters the Saturation. The triangular slider gadget 
referred to in step 10 may be used to alter the Luminosity of the chosen colour. Also 
individual values within the range of 0-255 may be entered in either the Hue, Saturation 
(Sat), Luminosity (Lum) boxes or the Red, Green, Blue boxes to change the colour. Use 
Cancel to remove the stack of dialog windows so that you are back at your map display. 

Duplicating regions or full maps 
Using the left mouse button define a rectangular area of interest, set it to about one 
quarter of the existing map size. 

Now select Dllplicate from the Map menu (or alternatively select the Duplicate button 
on the toolbar.) 

This will copy the contents of the map contained within the regio'n to a new window but will' 
retain the same colour detail as in the original. 

Position the mouse pointer somewhere over the legend of this new map and using the 
Quick Menu, deselect the Legend menu item. 

This will force a redraw of the map display. With the legend out of the way, there is more 
mom to display a larger representation of the zoom area that you duplicated before. 

Notethat if you do not define a zoom region when you duplicate a map, then the same 
map extent in the source map is used as the map extent in the duplicate copy. 

Displaying more than one map at a time on 11w screen 

Select lile from the ifindow menu to display the original and duplicated region side by 
•side on the screen. 	 •1 

You can'have any number of maps up on the screen at the same time (as available 	- 
memo!', allows). To see all of these at once, use the tile function. However, each map may 
will be rather small if you attempt to tile a number of maps at once. Removing the map 
legends can improve the individual map visibility by allowing more space in each window 
for its map display. In the situation where you wish to have a lot of maps (or even a couple 
of large ones) on the screen at the same time, the Cascade option in the Window menu 
may be a better choice as it will allow for maps to be stacked one behind the other. 

V. Select Legend from the Qptions menó to redisplay the legend and rebuild the map of 
the zoomed in areathat you duplicated a few steps ago. 



Select Cascade from the ifindow  menu to redisplay the maps one behind the other. 

By holding down the Ctrt key, and then pressing the Tab key, you can scroll through your 
maps one at a time. Note the fast refresh rate because each map does not have to be 
rebuilt for redisplay. 

It is important to note that only ONE window has the focus at a time. That is, menu 
operations will only apply to the currently active map window. This is easily identified as the 
window in front of all other displayed windows and with a highlighted title bar. Clicking with 
the left mouse' button over a chosen window will bring it into focus. 

Remember that map windows can also be revised an dior repositioned by dragging their 
edges or title bar with the mouse. 

Defining the screen position and size for a new map 

Select New map and choose the Options tab. Now select the ifindow button and click 
on OK in response to the instruction window that appears. A crosshair should appear 
on the screen. Position the crosshair at the desired corner position and drag it out to the 
opposite corner to define the new window size. Now release the mouse button and the 
Map Spcciflcaton window shoud reappear. 

Select the Base tab and select all categories of the Geology (Lithological classes) 
variable. Choose OK to display the new map at the position and with the dimensions 
defined in the previous step. 

Copying and Pasting specifications between maps 

You will now be introduced to a very powerful feature of W1nERMS, the ability to copy parts 
of one's specification to other displayed maps via the Windows clipboard. 

Bring the zoomed-in duplicate map of Solar Radiation to the foreground and make it 
the active window either by clicking on it or using CtrI Tab. 

Use either Map Contents on the Quick Menu or Contents on the Map menu to display 
the Map Specification dialog. Choose the Lines tab and select Line Layer. Add, 
Coastline/Estuaries and Watercourses to the selected lines (remember to hold down 
the Ctrl key while you click on the items). Press OK twice to display the edited map. 

Select Copy Contents from the Edit menu and then click on the boxes to the left of 
Zoom area and Lines. Press OK. 

You have now copied part of this map's specification (the current zoom area and active 
lines) to the Windows clipboard. 

Bring the Geology map to the foreground and make it the active map either by clicking 
on it or using Ctrl Tab. 

Select Easte Contents from the Edit menu. 

LIM 
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The map specifications you copied to the clipboard in 23 are now transferred to this 
map. The map should automatically zoom in to the area displayed on the Solar Radiation 
map and acquire the same lines as displayed on that map. 

26. Use any of the techniques you have learnt so far to position the two maps side by side 
for comparison. 



Tutorial 3: Using the new WinERMS data types. 

Tutorial 3 demonstrates the three new WInERMS data types. These are the Point, the Vector 
and the Polygon types. An important feature of these data types is the ability to link spatial 
entities within a WinERMS database to attribute information held in an external database 
management system (DMBS) table. 

Introducing the POINT data type 
The POINT data type allows locational records of plants, animals, cultural sites etc to be 
stored as exact points within WInERMS instead of being generalised to grid cells. These 
points can also be linked to attribute information held in a DBMS table. In this example, 
Honeyeater records have been exported from an Advanced Revelation database and 
converted to DBASE IV form'at. The geographical locations of these records have been 
loaded into W1nERMS as a point variable, and a direct link established between this 
variable and the DBASE file. 

Select New Map and choose the Base tab. Select the Honeyeater Records 	variable, 

choose the first three categories and click on OK. 

Note the POINT data type icon in the variable list next to the Honeyeater Records item. 

Click on the Options tab to activate it. Click on the Zoom Area button to display the 
Select Zoom Area dialog window. Choose 'Northern Section' from the Zoom area list 
Click on OK twice to display the map. 

Note that a number of records are displayed on the map. This was the reason for 
restricting the selection to only three categories and choosing a sub set of the entire 
database area for the display. Otherwise, the map would have displayed an 
indistinguishable cloud of points. 

Now zoom in a couple of levels to provide a clear view of some of the individual 

records. 

Note that each record is defined by a symbol and 8 label is displayed to the right of the 
symboL When establishing a DBMS link any field of the DBMS table can be nominated as 
the label field, the contents of which are then used to label individual entities (records). 

To access more information about a particulSr point, double click with the left mouse 
button near to the chosen point. A DBMS Query Result window will appear which 
displays the contents of the DBMS record associated with this point 

You ha ye just carried out a 'point and click' database query. 

Click on the close button in the DBMS Query Result window to remove it from the 
display and then zoom back out to where the records appear tightl' clustered and 
somewhat indistinguishable. 

If you zoomed too far back, so that the entire database area is displayed, then select Map 
Contents from the Quick Menu. Now use the Options tab to select the Northern Section as 
you did in step 2. Select OK twice to redisplay the map. 

Use the left mouse button to define a rectangle around a clustered group of points. This 
procedure is the same as for the zoom in function. 

Select Zhow Info from the Quick Menu or click on the Display DBMS Information 
button in the toolbar. A stack of Query'Result windàws should appear (if there was 
more than one item in your defined query region). Clicking on the Next a> and csPrev 



buttons in each window allows you to scroll through the stack of DBMS records for all 
points falling within the specified rectangle. 

Note: do not close the map created using Honeyeater records as it will be used later in the 
tutoriaL 

Introducing the VECTOR data type 

The VECTOR data type is similar to the POINT type except that each entity does not 
consist of a single point but rather a vector defined by a series of points (vertices). In this 
example, named 'Wild and Scenic Rivers', a DBASE IV file is linked to a W1nERMS 
vectors variable. 

Select New Map and choose the Top tab. Select the 'Wild & Scenic Rivers 	variable, 
choose the first five cateOories and click on OK. 

Note the VECTOR data type icon in the variable list to the left of 'Wild & Scenic Rivers'. 

Click on the Options tab to activate it. Click on the Zoom area button to display the 
Select Zoom Area dialog window. 

Define a zoom area as follows: double click in the Minimum Easting box, and type the 
value 400000. Now press the Tab key and type 450000 in the Maximum Easting box. 
Press the Tab key and type 800000 into the Minimum Northing box. Press the Tab 
key and type 850000 into the Maximum Northing box. Finally, press the Enter key or 
click on OK to register the selection. Click on OK to display the map. 

Using the Tab key to navigate through a series of edit boxes asdescribed above is a good 
way to enter a collection of data into a dialog window. 

Carry out point & click type queries and some region type queries as described in the 
POINTS section of this tutorial. Note that the operations and results are much the 
same as with the POINT data type. 

Using POINTS and VECTORS on the same map 

Select lile from the Wndow menu to redisplay both the POINT and VECTOR maps 
side by side. To improve the size of the map display in each window, turn off the 
legends of both maps. To turn off a]egend click on the map while holding down the 
left mouse button and select Legend from the Qptions menu or position the mouse 
pointer over the legend and use the Quick Menu to disable the legend. 

Next, copy some of the specifications from the VECTbR map to the POINTS map. 
This is done by selecting the VECTOR map and choosing Copy Specification from the 
Edit menu to display the 'Copy Specification to Clipboard' window. Use the left mouse 
button to select lop, Zcom Area and Tgp Colour so that the adjacent check box has an 
'X' in it. Then select OK to copy your chosen specifications to the clipboard. 

Use the left mouse button to select the POINTS map. This will be the destination for 
the paste operation. Choose Easte Contents from the Edit menu. 

Note that you have now created a composite map with 'Honeyeater Records' as the base 
layer and 'Wild & Scenic Rivers' as the top layer. Furthermore, your user defined zoom 
area has also been pasted. At this stage close the original VECTOR map as we will be 
using only the composite map in the next iafl of the tutoriaL 



Maximise the map and select Legend from the Qptions menu to provide a better view. 

Now carry out some point & click or region type queries as described in the POINTS 
section. 

Note that the results you obtain refer ONLY to the 'Honeyeater Records' in the base layer. 
Point & click and Region type DBMS queries can operate on only ONE layer at a time. 
If only one of the new data types occurs on a map, then the DBMS fookup will default to 
that layer whether it is Base or Top. 

Introducing the POLYGON data type 

Entities within the POL YGON data type are defined by a vector boundary and a centroid 
(!abel) point. As with the point and.vector examples, a DBMS table is linked to the polygon 
variable, 'Service Estate'. 

Close the composite map that you produced in the previous section and open a new 
map. 

Select the Base tab, select 'Service Estate' and select all categories by double 
clicking on the variable. 

Note that this type has'it's own icon to distinguish it from the other WInERMS data types. 

Select the Options tab, click on the Zoom Area button and choose 'Southern 
Section' as the zoom area for this map. Click onOK twice to display the map. 

Zoom in and out of some areas of interest to get a closer view of the various polygons 
that are displayed. 

Carry out some point & click and region type queries. Note that this type of query is 
basically the same as for the POINT and VECTOR data types. 

We will now carry out a database query based on particular attribute criteria. Note that this 
facility is also available for POINT and VECTOR data types. 

Choose Edit map and select the Base Layer tab. Now click on the ZQL ... button to 
display the 'Build DBMS Query' window. 

The 'Build DBMS Query' window allows the user to produce a DBMS query by selecting a 
field, an operator for the expression, and a value. These individual expressions can. then 
be connected by applying the Boolean connectors AND or OR by clicking on their• 
respective buttons. 

For this example, we wish to display only those polygons that fall within the Hunter district 
This is appropriate given that the zoom area selected in step 22 covers most of this district 

Firstly, select 'DISTRICT from the Lields list. Note that a listing of the possible values 
for this field appears in the value list. Secondly, select the '=' pperator and finally select 

'Hunter' from the value list. Now click on OK to display the 'SQL Result Name' window. 
Type in 'Hunter Service Estate' as the name for this query result and click on OK twice to 
redisplay the map. 

The method that you applied is known as 'query by example'. Note that you can still use 
the point & click or region type query to obtain further information on each of the spatial 
entities selected by SQL query. Next, reduce the items displayed even further by restricting 
the entities selected from the database to those reserves of a specified total area (ha). 



This will demonstrate the linking of SQL expressions through the use of Boolean operators 
in the query by example window. 

Edit the current map via the Base tab and SQL button to redisplay the query by 
example window as above. Select DlSTRlCT = "Hunter" as described above. Now 
click on the AND button and select the expression 'AREA_HA,> 19272". Click on the 
AND button again and select the expression "AREA_HA < 92596". 

If you want to edit the SQL expression that you just produced, click on the ffdit SQL... 
button. Click on OK once you are happy with the expression. If you wish to redo the query 
at this point, click on the New Query button to clear the previous one. 

Click on OK to display the Overlay Name window. Type in a new name or just press 
the Enter key or select OK to register the new user defined variable. 

Note that by ti typing an Oveday Name into the text box, WInERMS will simply refer to 
your Current Selection in the Map Specification window as "SQL Query Resulr. 

Click on OK in the Map Specification window to redisplay the map. 

Try some point & click or region type queries. You should find that the only polygons 
selected form part of either Myall Lakes NP or Barrington Tops NP. 

Display and colour selection options for the new data types 

Each of the new data types has Mo or more components that can be displayed on a map. 
All three types can display 'cent roid' symbols and 'labels'. The vector and polygon types 
also have 'vector' and 'gridcell' components. The gridcell component for a vector variable 
represents all the gridcells that the vector features pass through, whereas for a polygon 
variable it represents all the gridcells contained within the polygon features. By default, the 
gridcell component,of vector and pOlygon variables is not displayed. Activating the gridcell 
component of a polygon layer is an easy way of shading polygons. Selection of the 
components to be displayed and control of their colour and style is achieved via the Qolour 
button in the Base or Top Layer tab. Click on the Colour button to display the Category 
Colour/Style dialog window. 

In the bottom left hand corner of the dialog box is the 'Display' group. By selecting any 
combination of the Centroids, Labels, Vectors or Gridcells, you can define the components 
displayed. Note that the, map redisplay speed will be enhanced by NOT having Gridcells 
turned on. If you wish to have Gridcells displayed, then setup all the other display 
parameters first and Once you are happy with the display, then turn the Gridcells on. Since 
the POINT data type does not include Vectors or Gridcells, these will be greyed out in the 
'Set Colour For' and 'Display' groups if a POINT variable display is being edited. 

To the right of the 'Display' group are the 'Set Colour For' tab panels. By clicking on any of 
the panel tabs, the colour icon to the left of each category in the Categories list will alter to 
reflect the component being edited. 

Clicking on the 'Centroid' tab panel will display the centroid and it's currently selected 
colour. This can be altered by selecting a category or categories and choosing a colour(s) 
from the available palette. The advanced colour selection features discussed in tutorial 2 
may be applied hem too. The Symbol list box is used to select a new centroid symbol from 
the ten available types. These are basic geometric symbols that have filled and unfilled 
variants. The display size of these centroids can be selected from the Size list box. 
Choosing a size is the same as selecting a point size for a font If the default sizes are not 
appropriate, then you can define your own by typing an integer value into the list box. 



Clicking on the 'Label' tab panel will display a 'T' next to each category. The display colour 
for the label can now be selected from the palette. To choose the font that you wish to use 
for a particular category's label, click on the Label Eont button to display a standard 

• 	 Microsoft Windows dialog window. Here you can select the font style, it's display attributes 
• 	 (normal, bold, italic or bold italic) and the font point size. 

• 	 Clicking on the 'Vector' tab panel will display the line colour, the line type and its weight 
next to the category name. The colour may be edited as usual with the palette: The line 
type and weight may be selected from a set of eleven styles in the Eattern list box. 

Clicking on the 'Fill' tab panel will display the gridce!l colour and styles. This is exactly the 
same as with any gridcell variaØle so refer back to the relevantsections of tutorials I and 2 
for more information. 

31. Try changing the way in which polygons are displayed in the current map using the 

above techniques.  
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Tutorial 4: Enhanced Boolean overlaying in WinERMS 

This tutorial is in three parts. These parts introduce a number of enhancements to Boolean 
overlaying in WinERMS. 

If you have any map views currently on the screen, then close them in preparation for this 
tutorial. 

Using a new data type in a Boolean overlay 
This section uses the new Vector data type in a Boolean overlay to create a domain. The 
domain is applied over a gridcell base layer, and a Vector top layer. 

Select New Map to display the Map Specification dialog window. 

Click on the Domain tab to activate it. Click on the Domain button to display the 
Domain Selection window. Click on the Boolean button to display the Boolean Overlay 
window. 

Select the Wild & Scenic Rivers variable and click on the Add button to display the 
Boolean Categories window. 

Choose the 'RIVER 4' item from the categories list box. 

Select on the 'Generate Zone of Proximity' button and select the 4000m item from the 
Maximum list. 

Choose OK. The Overlay Name window is displayed. Type in a name or just click on 
OK to create the overlay. The mouse pointer will change to an hourglass cursor while 
the overlay is created. You will then be returned to the Map Specification dialog 

window. 

In steps 2 to 6, you created a 4km buffer zone about River 4 (the Nyniboida River) whiih 
will be used as a Domain to mask out all data that do NOT fall within this area. 

Create a Base Layer 

Click on the Base tab to activate it. Click on the Base Layer button to display the Select 
Base Layer dialog window. 

Choose the Land Tenure variable, and select all the categories. Choose OK to return 
to the Map Specification window. 
(short-cut: double-lick on a variable to select all its categories and return to the Map 
Specitiation window) 

Create a Top Layer 

Choose the Top tab, and select the Top Layer button to display the Select Top Layer 

window. 

10.. Select the Wild & Scenic Rivers' variable • and choose the 'RIVER 4' category. 
Choose OK to return to the Map Specification dialog window. In the Map Specification 
dialog choose the OK button to display the map. 

11. Zoom into the area around the displayed buffer zone and maximise the map to show 
more detail. (You can get more details about the sections of the River via a Point & 
Click query, or a Region query as described in tutorial 3). 



You have completed section one of the tutorial. Close the map view and continue with the next 
section. 

Using the Extended Boolean Overlay Capabilities of W1nERMS 

This pad of the tutorial will use the extended boolean overlay featUres of WInERMS to 
predict distribution of a hypothetical plant species given particUlar habitat requirements. 

The habitat of our species is identified as being either Moist Open Forest on a Basic 
Igneous geology or Rain forest Suitable habitat is also confined to elevations greater than 
900m. 

In DOS E-RMS, such an overlay would not be possible to create directly, but would require 
the creation of a number of temporary variables. 

In WInERMS, the overlay can be created directly by using the extended Boolean 
functionality. 

The Boolean equation that needs to be solved in order to predict the habitat is as follows: 

Elevation > 900m AND ( Rainforest OR ( Moist Open Forest AND Basic Igneous 

A logical approach to solving Booloan equations such as this is to work from the inr.ermos 
part of the expression to the outermost part. WInERMS takes care of the creation and 
deletion of temporary variables needed to accomplish this task 

From the Map menu, choose New Map 

Choose the Base tab, and click on the Base Layer button to display the Select Base 
Layer dialog window. Click on the Boolean button to display the Boolean Overlay 
dialog window. 

First we solve the innermost expression. That is, we do a Boolean Overlay of Moist 
Open Forest Vegetation AND Basic Igneous Geology. 

Select the Vegetation Systems (Landsat TM) variable and click on the Add... button to 
display the Boolean Categories dialog window. Select the Moist Open Forest category 
and click on OK to return to the Boolean Overlay window. Now select the Geology 
(Lithological Classes) variable and agafri click on the Add... button to display the 
Boolean Category dialog window. Select the Basic Igneous Rocks category and click 
on OK to return to the Bdolean Overlay window. 

a 

Note that the Result list now contains the Vegetation Systems and Geology variables. 

Click on the <<<AND button to perform this, initial boolean overlay. 

Note that a new variable called Temporaryl appears in the variable list 

Now we will solve the next stage of the equation 'by ORing the Rain forest category of 
Vegetation Systems with Temporaiyl. 

Select the Vegata'tion Systems variable and, click on the Add.. button to display the 
Boolean Categories window. Select the Rainforest category and click on OK to return 
to the Boolean Overlay window. Select the Temporaryl variable and click on the Add... 
button to display the Boolean Node window. Click on OK to register the selection and 
return to the Boolean Overlay window. 



Note that the Result list shows the Vegetation Systems variable plus the Temporaiyl 
variable. 

Click on the <cc QR button to produce a new temporary variable. Note that this new 
variable, called Temporary2 appears in the variable list. 

We solve the final part of the equation by ANDing the Elevation classes above 900m 
with Temporary2 to create our final result. 

Select the Elevation (lOOm classes) variable and click on the Add... button to display 
the Boolean Cateories dialog window. Select all elevation classes greater than or 
equal to 900m and click on OK to return to the Boolean Overlay window. 

Select the Temporary2 variable and click on the Add... button to display the Boolean 
Node window. Click on OK to register the selection. Note that by selecting OK, all the 
variables in the right hahd list box are ANDed together by default. 

Now finally click on OK to to accept the Boolean overlay and display the Overlay Name 
window. Either type in a name and press Enter, or just click on OK to create the 
Extended Boolean Overlay. The mouse pointer will change to an Hourglass while the 
Boolean Overlay is built. 

Click on OK to display the predicted habitat that you just created. 



Tutorial 5: Printing a map from WinERMS 

Tutorial 5 introduces you to printing hardcopy maps from WInERMS. The tutorial focuses on 
features for enhancing map presentation and setting up the map and legend to produce a 
good quality hardcopy. 	 - 

Creating the WinERMS map. 

The primary components of the map are an elevation base layer and a Service Estate top 
layer (of the polygon data type). Line features are used to enhance the base and top 
layers. 

Set up a BASE Layer 

• 	 1. Select New Map and choose the Base tab. Select Base Layer and choose all 
categories of the Elevation variable by double clicking on this item in the variable list 
box. Select OK. 

If you are working with a colour printer, you will need to edit the colours to increase their 
luminance. This will result in much better definition between the base and top layers. To do 
this, click on the jolour button to display the Gate gory Colour/Style dialog window and 
then click on the Bamp... button to display the Colour Ramping dialog window. 

Click on the start Colour DetaiL., button to display the Colour Detail dialog window. Enter 
the value 215 in the Lum text box. Notice that the slider gadget next to the colour selection 
palette moves upward towards the white end of the scale. Click on OK to return to the 
Colour Ramping dialog window. 

Next, click on the End Colour Detait.. button to display the Colour Detail dialog window. 
Carry out the same operation to increase the luminance of the end colour: Click on OK to 
return to the Colour Ramping dialog window. 

While the colour ramp has been maintained the increase in luminescence has resulted in 
more subtle colours. 

Now click on the OK button twice to return to the Map Specification dialog window. 

Set up a TOP Layer 

Click on the Top tab to activate it. Click on the lop Layer... button to display the Select 
Top Layer dialog window. Click once on the Service Estate POLYGON variable. Select 
the National Park's and Nature Reserves categories by holding down the left mouse 
button and dragging the cursor over them. 

Select OK to return to the Map Specification dialog window and click on the colour... 
button to display the Qategory Colour/Style dialog window. Ensure that the Centroids 
tab panel is selected. 

Select both the National Park and Nature Reserve categories in the list box. Set both 
categories to be displayed in black by clicking on the black colour box in the palette. 
Then set their point size to 5 in the Size list box. 

Note that the operations so far have applied to both categories. The next operation applies 
to individual categories only. Therefore, select the National Park category on its own first 



The default symbol used for POLYGON centroids is the filled triangle. Retain this as the 
centroid symbol for the National Parks category. 

Select the Nature Reserve category in the list box and choose the open triangle symbol 
from the fattern list box. 

The next step is to modify the POLYGON/abet Select the Label Tab PaneL Select both 
categories in the category list box. Note the 7' icon next to the items in the list box. 

Click on the Label Eont... button to display the Font dialog window. Select an 8 Point 
Ar!al Font in a Regular style and click on OK to return to the Colour Category/Style 
dialog box. 

Next select the vector tab panel, and select both categories in the category list box. Note 
that the default single thickness line type is displayed next the categories in the list box. 

In the Weight list box, select the 2pt item. Note that the change is reflected in the 
displayed lines next to the items in the category list. 

The final POLYGON component to set up is the Gridcell display. Select the Fill tab paneL 
Note how the display next to each item in the list box has changed to look the same as for 
any grid cell variable. We will be using black for both categories but a different hatch 
pattern for each category. Givcn thatwa currontly have both catcgcdcc solsctcd, choose 
the black colour from the palette to set the co/qur. Now we need to select each category 
separately in turn for the hatch pattern. 

Choose the National Park category only. Select the fourth item, a coarse 45 degree 
angle hatch, from the fattern list box. Now choose the Nature Reserve category and 
select the seventh item, a coarse 90 degree hatch from the fattern list box. 

Note that the new hatch patterns are displayed next to their respective categories. 

In the Display group, make sure that ALL the check boxes are selected for the map 
display. Click on OK to return to the Map Specification dialog window. 

Set up a LINES layer 

Click on the Lines tab to activate it. Click on the Lines Layer... button to display 
the Select Lines dialog window. 

Select all of the items except the first In the fiorder  group option, select Map Border 
with Gridlines, and click on the 10,000m grid radio button to select a 10km grid 
resolution. Click on OK to return to the Map Specification dialog window. 

Click on the colour... button to display the Line Colours and Styles dialog window. 

Select the MAP BORDER WITH FULL GRIDLINES item. In the style list box, select - 
the single dashed line style. ie . the second item in the list Ensure the colour of the 

item is black. 

Select the next three items in the Line list, the NEFBS Study Area Boundary, the 
Coastline I Estuaries and Watercourses. These should all be black with a single solid 
line style. 

Select the last two items: Highways and the Major Roads. Select red from the coloir 
palette. Select the double thickness solid line style from the style list box. 



Note that as with previous layers, altering the display colours and line styles is reflected in 
the list box display next to each line category. 

Click on OK to return to the Map Specification dialog window. 

Setup a map zoom area 

Click on the Options tab to activate it. Click on the Zoom Area... button to bring up the 
Select Zoom Area dialog window. To define a map area, type the following AMG 
coordinates in the Define Zoom Area group: 

• Minimum Easting: 376600 
• Maximum Easting: 508000 
• Minimum Northing: 700000 
• Maximum Northing: 877800 

Press Enter to return to the Map Specification dialog window. 
"-I 

Then click on OK to display the map. 

Note that the displayed.map tends to accentuate the relative thickness of the line types and 
POLYGON vectors. Don't worry about this as the screen does not have as fine a resolution 
as the printer. The final output should give good delineation between the various line 
coiours and styies chosen. 

Click on the Maximise button in the top right corner of the map view window to display 
the map at its largest so as to improve.the visual detail. 

Printing the WinERMS map 

Select a printer 

Choose Pjint Setup... from the Ste menu to display the Printer setup dialog window. 

Ensure that the settings displayed in the window are appropriate for the printer that 

L.J 	 you are using. For more information on setting up printer parameters refer to your 
Microsoft Windows manual. 

Set the map Orientation to Portrait because the zoom area is greater in height than in 
width. For this example, print your map on an A4 size sheet. Size is chosen in the Size 
text box within the Paper group. 

Select OK to register the printer settings. 

Position the map and legend on the printed page 

Choose Page Selup... from the Eile menu to display the Page Setup dialog window. 

Note that you can also access Page setup by choosing Erint from the Elle menu and 
clicking the Page _Setup button on the Print dialog window. Conversely,, the Print dialog 
window can be accessed by clicking on the Print., button on the Page Setup dialog 
window. 

This is a good time to discuss some of the functions available in Page Setup. 



Firstly the Map Scale group allows you to select map scale and the number of pages a 
map prints onto.ln this example, we will choose the default to print the map one single 
page. Page size is chosen in the Print Setup dialog window. To print your map at a 
particular scale click on the Scale By radio button and choose either one of the default 
scales displayed in the list box or type in a scale. Note that if the scale defines a map that 
is too large to fit on one page the map is automatically sectioned across several pages. 

The middle group allows you to select whether to print the map legend or not Use the 
default setting to print the legend. 

The bottom group defines the margins amund the map edge.. It also allows you to centre 
the map vertically and/or horizontally on the page. Use the default settings to centre the 
map on the x andy axes. 

Click on the Legend... button to display the Legend Design dialog window. 

Note that this dialog window consists of tabs as in the Map Specification dialog window. 

Click on the Title tab to activate it. Enter a title for the map and set up the title position 
by selecting a Justify Title radio button. Click on the font... button to display the Font 
dialog window and select a 9 Point Anal Bold style font for the title. 

Click on the Features tab to activate it. The Layers group allows you to choose which 
map components to include in the Legend. Select only the Top and Lines layers. Use 
the defaults for the columns group in order to define how the selected layers are - 
presented in the legend. The Options group allows you to choose whether or not to 
print the map scale and the grid interval. Select to print the map scale but not the grid 
interval. Also, you can choose to have either no legend border, a single line legend 
border or a double line legend border. Use the default for a single line border. 

Click on the Position tab to activate it. This allows you either print the legend on a 
separate page or to include the legend on the same page as the map. Select to 
display the legend on the same page as the map. In order not interfere with the grid 
numbering display, place the legend 1.7cm in and 1.4cm down from the top left hand 
corner of the page by entering these figures into the X and i text boxes respectively. 

Click on OK to return to the Page Setup dialog window. Click on the Print.., button to 
display the Print dialog window. 

The map will be constnicted in computer memoiy before being sent to the printer. A 
window will appear over your map indicating percent completed. The printing process can 
be aborted by clicking on the cancel button while the map is being constructed in Themory. 
When the map has been sent to the printer the status window will disappear. At this stage, 
you can begin working on a new map or exit from WInERMS. 
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Contents of WInERMSNegotiation Database for Northern 
Study Area 

The database contains data layers to be used in Interim Assessment negotiations for all 
Northern Negotiation Regions (i.e. NI to 116). These data layers are being used to create the 
'compartment by feature' matrix employed by the interactive conservation planning tool. The 
derived matrix and the conservation planning software are not included in the provided 
database. Reservation targets for the conservation features are also not included. 

Data for all six Negotiation Regions are stored in a single WinERMS database covering the 
entire Northern Study Area (at 1 OOm grid resolution). The user can either view data layers for 
the entire Northern Study Area, or zoom in to any Negotiation Region oflinterest. (t. 
'predefined zoom area' has been specified for each Negotiation RegiQn). 

.At the time of initial supply (15/4/96) the database contains data jayers for all conservation 
features to be used in the Interim Assessment negotiations (forest types, old growth, species 
models, species locality records). The database does not yet include 'land unit' boundaries 
(for compartments and other tenure classes) or the wood resource data associated with land 
units. These layers are still being prepared by State Forests and will be supplied as additions 
to the WinERMS database as they progressively become available for Negotiation Areas, 
witb priority given to areas scheduled for the first weqk of negotiations (NI and N2). 

- 	The data layers provided.in  the database we dospribe4 below. Data quality statements are 
currently belpj prepared for all of these ;ayer;, and will be provided when available. 

..fl$4cdll Phil and Polygon Variables 

Forest Types 

Each category of this grid cell variable contains the extAnt distribution of a Fo?est Type 
(including, where appropriate, subtypes endorsed by the Flora Panel). The data in the 

variable are a mixture of real ForestTypO mapping, other fine-scale vegetation mapping 

converted to Forest Types, and predictive modelling where vegetation mapping was not 

available. The Covera;e of Forest Type Mapping variable indicates which areas are based on 

real *getation mapping as opposed to predictive modelling. 

Each grid cdl is assigned to a single pure Forest Type. Where two or more Forest Types have 
been mapped, or predicted, as occurring in an area then these types are randomly allocated to 

grid cells in proportion to their probability of occurrence. For example, if an area is predicted 
as consisting of 80% Forest Type 163 and 20% Forest Type 150 then 80% of the grid cells in 
this area will be assigned to 163 and 20% to 150. Grid cells assigned10 each type are 
distributed at random throughout the area in question. Thiscounts for the speckled pattern 
of cells in parts of the study area. CautiOiimuSt b&èxercised in interpreting the exactiocation 
of grid cells assigned to a Forest Type in areas where more than one type has been mapped or 
predicted. This is especially so in areas where modelling has been used to predict Forest 

Type composition (see the Coverage of Forest Type Mapping variable). Random assignmeflt 

of grid cells to Forest Types is also employed in areas mapped as a mixed Forest Type (e.g. 
1/12), in which case cells are randomly assigned to the component pure types with equal 
probability. A similar approach has been used in areas where detailed Forest Type mapping 

/ 
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is not available, but State Forests have mapped broad forest classes forEJS purposes. Grid 
cells in these broalclasses have been randomly assied to Forest Types using estimated 
proportions of Forest Types occurring in each class, provided by.State Forests. 

Coverage of Forest Type Mapping 

The two categories in this grid cell variable distinguish between areas where real Forest Type 
mapping was available (including mapping of broad classes by State Forests) as opposed to 
areas where modelling was employed to predict Forest Type composilioli. The variable can 
be used in conjunction with the Forest Types variable (e.g. as Base and Top layers) to 
facilitate interpretation of the reliability of Forest Type data in different parts of the region. 

Growth Stages 

This grid cell variable contains the growth stages derived from the broad old growth mapping 
project. The Rainforest category was derived by 9ierging areas mapped as rainforest by th! 
old growth project with areas mapped as rainforèst in the Forest Type variable. The other 

LI 	. 	growth stage categories were derived from mapped growth classes, forest type site quality 
classes and disturbance history using tabulated rules endorsed by the RACAC Conservation 
Working Group. 

F. Type I Growth Stage (30-92) 

This variable contains combinations of non-rainforest Forest Types 30 to92, subregions and 
growth stages. The subregions within each Forest Type are those defined by the Flora Panel. 

They are nQt negotiation regions, but rather geographical divisions of a Forest Type for the 
purposes of setting reservation targets. The subregions and associated reservation targets are 
documented in the Flora Panel report. - 

Each combination of Forest Type and subregion is further divided into two categories on the 
basis of growth stage. The first category is old growth, as mapped in the Growth Stages 
variable, while the second' category is an imalgamation of all other growth stagcs and the 
undetermined class. 

The coding of categories in the variable is as follows. The first character indicates the growth 
stage (O=old growth, Rother). This is followed by the Forest Type number, with a subtype 
number in brackets if applicable. If a Forest Type has been divided into subregions then the 
subregion number is indicated after a slash. For example, the '0 I63(1)/2 category contains 
the distribution of old growth Forest Type 163 (subtype 1) within subregion 2. 

F. Type I Growth Stage (93-215) 

This variable is a continuation of the previous variable, for Forest Types 93 to 215. 

Rainforest (wltb 30% spatial filter) 

The single category in this variable cOntains the distribution of rainforest after application of 
a spatial filter to remove small, isolated occurrences. The filter is based on a 1km by 1km 
square centred on each grid cell mapped as containing rainforest. The grid cell of interest is 
retained by the filter only if more than 30% of cells in the 1km square also contain rainforest. 
This approach to identifying core areas of rainforest was formulated by the RACAC 
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Conservation Working Group. It should be noted, however, that the role to be played by 
rainforest in the Interim Assessment negotiations is not yet fully resolved. 

The unfiltered distribution of rainforest is contained in the Rainforest category of the Growth 

Stages variable. 

Extant Vegetation Cover (Landsat TM) 

The single category in this variable depicts the distribution of uncleared vegetation'across all 
land tenures within the study area, based on visual interpretation of 1:100,000 Landsat TM 
imagery. The data were derived from the Eastern Bushland Database established by NSW 
NPWS. The variable is intended to provide contextual information to negotiators, of 
particular relevance tg reserve design (e.g'identificatiofl of potentiaFwildlife'corridors). 

Frog Models 

This variable contains the modelled distributions of frog species selected by the Fauna Panel 
for consideration in the Interim Assessment. The categories are combinations of species, 
subregions and predicted habitat classes. The subregions within each species are those 
defined by the Fauna Panel. They are gjj negotiation regions, but rather geographical 
divisions of a species for the purposes of setting reservation targets. The subregions and 
associated reservation targets are documented in the Fauna Panel report. The predicted 
habitat classes have been derived using rules formulated by the Fauna Panel, incorporating 
models developed by the NSW NPWS North East Forests Biodiversity Study in conjunction 
with expert knowledge of the association of species with Forest Types and growth stages. 
The habitat classes are assigned weights reflecting their relative contribution to a specified 
reservation target. The rules for deriving habitat classes, and the weights assigned to those 
classes, are documented in the Fauna Panel report. 

Categories in the variable are coded with a speciesnaine, subregion number and habitat class 
on a 1 to 3 scale, where loptintum habitat. 2=sub.optimum habitat and 3=marginal habitat. 

Reptile Models 

As for Frog Models; 

Bird Models 

As for Frog Models. 

Non-volant Mammal Models 

As for Frog Models. 

Bat Models 

As for Frog Models. 

Fauna Locality Records 

This point variable contains locality records for all fauna species selected by the Fauna Panel 
for considration in the Interim Assessment. Each category contains a combinatibn of species 
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and subregion. The subregions within each species are those defined by the Fauna Panel. 

They are mu negotiation regions, but rather geographical divisions of a species for the 
purposes of setting reservation targets. The subregions and associated reservation -targeLs are 
documented in the Fauna Panel Eeport. Categories are coded with a species name followed by 

a subregion number. 

Additional-information relating to each of these records is contathed in a database-table 
linked to the variablc.See the accompanying installation guide for instructions on how to 
activate this link (only available if you have ODBC drivers installed on your computer). 
Once the link is activated you can double click on any displayed record to obtain further. 
information. An explanation of the fields contained in the linked database is provided in a 

printed table atiached to this document. 

Flora Locélity Records 	 - 

- - 	 This point variabiceontains locality records for all flora species selected by the Flora Panel 
for consideration in the Interm Assessment4 The records for each species are divided into two 

-categories. The first category (labelled with a'ft an4Fsuffix)  contains those records identified 

- . 	
by the Flora Panel as requiring'mahdator3r(i.ç39O%rotection. The second category 

(labelled with an 'bther suffix) contains those records for which only a specifiodpercentage 

(less than 100%) of records need to be reserved. Tlwse  categories and targets-are documented 

In the Flora Panel report. 

Additional information relating to each of the records is contained in a database table linked 
to the variable. See the accompanying instaliatioz gui4e for instructions on how to activate 
this link (only available if you have ODBC drivers initsUed on your computer). Once the link 
is activated you can double click on any displayçd record to obtain tijrther information. An 

explanation of the fields contained in the linked 4tebase is provided in a printed table 

attached to this document. 

Towns 	 - 

A point variable that may assist users In identifying locations within the study aiea. This is 

	

- best selected as a iop Layer. 	 .- 	 - 

Line Layers 

Major Roads 

These may assist in identiing locations in the study area 

Negotiation Regions 	- - 

Boundaries 
of Interim Assessment negotiation regions (Ni to N6). The initial version of this 

layer is based on coarse-scale digitising, and the boundaries do not aiign well with 
Management Area boundaries, roads. State borders etc. A refined version will be supplied 

when available. 	 - 
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1:100,000 Map Sheets 

Boundaries of all 1:100,000 topographic map sheets within the study area. 

1:25,000 Map Sheets 

Boundaries of all 1:25,000 topographic map sheets within the study area. 

PredefinedZoom Areas 

Zoom areas have been predefined for each of the negotiation regions (N Ito 146). Those cnable the user 
to rapidly worn in to a selected negotiation area. A predcfined zoom area can be chosen by selecting 
'Options' from the math Map Specification dialogue box, then Zoom Area...'. 

r 

p 

0 
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Database fields linked to the 'FAUNA LOCALITY RECORDS' 
variable 

FIELD NAME DESCRIPTION 
RECORD Key field that uniquely identifies each species record 
NUMBER 
SOURCE Source of the record: 
DATABASE WOATAGIS = Atlas of ?4SW Wildlife held at 01$ Unit Aimidale 

ATLASIJPD 	Atlas of NSW Wildlife HO update (07/95) 

LICENSE = NEFBS.LICENSE Fauna Data Application 
STATE FORESTS 	State Forests BIS data 
Records starting: "NZ-" a Other fauna data from NPWS Northern Zone 
Other sources may appear in this field; these indicate databases held within the 
NEFBS.FAUNA Data Application 

SITE NUMBER Site identifier for the  locality from which the record was obtained 

LOCATION Description of site locality 

RESERVE NAME Name of the reserve (National Park, Nature Reserve, State Forest, Flora 
Reserve or other reserve) from where the record was obtained 

ZONE Australian Map Grid (AMO) zone number 

EASTrNG AMO Lasting (6 digit) 
NQRTHLNG AMCI Northing (7 digit) 

ACCURACY Code for accuracy of the georeference: 
1= within 10 in 
2=within lOOm 	 - 
3= within 1km 

ALTITUDE ElevatIon (in metres) above sea level 

MAP NUMBER 1:100 000 map sheet number (CMA). 

CALCULATED 1:100 000 map sheet number (CMA) Calculated from the AMO Easting and 

MAP NUMBER Northing 
FIRST DATE First or only date of the record observation period 

LAST DATE Last date of the record observation period 

RECORDER Name of the principle data collector 

CAVS CODE Census of ­­Australian Vertebrate Species (CAVS): Unique codc1br each taxa 

SPECIES NAME Name of taxon: 
Conunon names are used for birds and non-bat mammals 
Scientific names are used for all other ftuna species 

RELIABILITY Code for the reliability of identification of the taxa recorded: 
- 1= Specimen with public museum 

2= Specimen with other collection 
3 	Voucher spçcinten used 
4= Reliable or verified 

p 
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Database fields linked so she 'FAUNA LOCALITYRECORDS' variable CONT. 

FIELD NAME DESCRIPTION 

OBSERVATION Method used to detect the taxa recorded: 

TYPE A = Stranding/beached 
B = Burnt 
C = Cat kill 

Dog kill 
E 	Nest/roost 
F = Tracks, scratclfmgs 
H = Hair, feathers, or skin 
M = Miscellaneous 
N = Not located 
0 = Observed 
P=Scat 

Road kill 
Shot 

T 	Trapped or netted 
V =Fox kill 
W=Heard 

In scat 
Y 	Bone or teeth 
Z =  In raptor/owl pellet 

NUMBER Number if individuals of the taxa recorded 

BREEDING Indicators of the breeding status associated with the record: 

EEggs 
J 	Juveniles 
L 	Lactating 
N - Nesting 

= Pregnant 
Y = Yes, but no details 
- 	Not breeding 

LEGAL STA11.JS Identifies the legal status of the fauna in NSW (as listed in the NSW NPWS Act 

1974): 	- 
U = unprotected 
P 	protected 
V = vulnerable and rare 
T = threitened 

TARGET_CODE X 	Indicated where the species is a target species 

NOTES her information relevant to the record 

COMMON NAME on name of the taxa recorded 

SCIENTIFIC , species (and subspecies if recorded) of the taxa 

NAME 
rName DATASET NAME of the dataset from which the record was obtained 

DATA USE  tions on data use (conditions specified by data custodians). The 

RESTRICTION ion of data must also comply with NSW NPWS Digital Data Release 
Polky, which may impose additional conditions of use specified within a 

licence agreement (see 3.1) 
UNRESTRICTED = Data are available to the public 
GOVERNMENT DEPARTMENTS ONLY = Data are only available for use by 

NSW State Govt departments 
SERViCE USE ONLY = Data are only available for use within the NSW 

NPwS. 
PROJECT SPECIFIC ONLY = Data to be used only for the lAP (not for public 

release) 
CATEGORY The species category name used for the faunipoint locality variable 
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Database fields linked to the 'FLORA LOCALITY R,ECO1WS' 
variable 

FIELD NAME DESCRIPTION 

RECORD Key field that uniquely identifies each species record 

NUMBER 

SOURCE Source of the record: 

DATABASE AGIS FLORA/SURVEY = AGIS FLORA data application 

AGIS SIGPLANTS 	AGIS SIGPLANTS data application 

HO SIGPLANTS = Head Office SIGPLANTS data application 

STATE FORESTS = State Forests ELS data 

NZ EXTRA RECORDS = Other plants data from NPWS Northern Zone 

SITE NUMBER Site identifier for the locality from which the record was obtained 

SOURCE FILE Source of the data (applies to State Forests data only) 

LOCATION Description of site locality 

RESERVE Name of the reserve (National Park, Nature Reserve, State Forest, Flora Reserve 

NAME or other reserve) from where the record was obtained 

ZONE Australian Map Grid (AMa) zone number 

EASTINO AMU Easting (6 digit) 

NORTHING AMO Northing (7 digit) 

ACCURACY Code for accuracy of the georeferenee: 

I=within lOm 
2= within IOU in 
3= within 1km 

MAP NAME - 1:100 000 map sheet number or maine (CMA) 

FIRST DATE First or only date of the record observation period 

LAST DATE Last date of the record observation period 

RECORDER Name of the principle data collector 

QUADR.AT Dimensions of the survey plot (metres) 

CAPS CODE Census of AustTalian Plant Species (CAl'S): Unique code for each taxa 

SCIENTIFIC Scientific names are used for all plant species 

NAME 

SIGNIFICANCE Categories of Conservation Significance in Upper N.E NSW (Slierringharn and 

CATEGORY Westaway, 1995) eg Carex capillacea "1,(3RC+),7,8N" where characters 

outside the '0' refer to Categories of Conservation Significance (with I always 

preceding the '0' and 2 to 9 proceeding the 1 0') and those inside the 'Q' refer to 

Categories of ROTAP (Briggs and Leigh, 1988) (see bilow) 
ROTAP Species (Rare or threatened Australian plant) 

(,.) 	ROTA? category (see Briggs and Leigh, 1988) (see below) 

2 = Uncommon throughout distribution 

3 =RareLnNSW 

4 = Regionally uncommon 

$ 	= Depleted habitat / sparse 

6 	= Locally endemic 

-7 	= Disjunct 

8 	DisLribUtional limits: N = Northern limit, S = Southern limit 

9 	- Atypical habitat 
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Database fields linked (o i/ac 'FLORA LOCALITY RECORDS' variable COJVT. 

FIELD NAME DESCRIPTION 
Categories of ROTAP (Rare or Threatened Ausutlian Plants(Briggs and Liegh, 
1988)) species eg Carex capillacea (3RC-+) (from above) where; (3 = 

Distribution Category; K - Conservation Status, C,-,+ - 

Conservation Reservation) 
Distribution Category 
I = Species known only from the type collection 
2 = Species with a very restricted distibution and restricted to a geographic range 

<100km 
3 = Species with a geographic range> 100 km but occurring only in small 
populations restricted to highly specific and localised 

habitats 
Conservation Status 
X = Presumed extinct 
E = Endangered 
V 	Vulnerable 
R=Rare 

Poorly known 
Conservation Reservation 
C = The taxa is known from a conservation reserve, NP/NR etc. 

a = This indicates that the species is considered adequately reserved with a 

population of> or = 100 plants known to occur within 
conservation reserves 

= The taxa is considered inadequately reserved 
- 	The species has been recorded within a conservation reserve butthdt the 
population size within the reserve is unknown 
+ 	Species which have a distribution exten4ing beyond the Australian continent 

The species population is known to occur solely within conservation reserves 

COVER Code for cover Abundance for individual species - either: 

ABUNDANCE 1= sparse <5% 
2=anynumber<5% 	 . 

3=5-25% 
4=25-50% 
5=50-75%  
6=75-100% 
or: 
VC = very.conIflIOfl 	

• 1 

C — common 
F=frequent 
0° occasional 
R=rare 

RELIABILITY Code for the reliability of identification of the taxa recorded: 
1= Specimen with public museum 
2 	Spdcimen with other collection 
3= Voucher specimen used 
4 	Reliable or verified - 

SURVEY Survey from which the record was obtained 



Database fletds linked to the 'FLORA LOCALITY )tECOR.DS' variable CONT. 

FIELD NAME DESCRiPTION 
DATA USE Restrictions on data use (conditions specified by data custodians) 	The provision 

RESTRICTION of data must also comply with NSW NPWS Digital Data Release Policy, which 
may impose additional conditions of use specified within a licence agreement 
(see 3.1) 
UNRESTRICTED = Data are available to the public 
GO VERNMENT 	Data are only available for use by NSW State Goverthnent 

departments 
NPWS = Data are only available for use within the NSW NPWS 
PROJECT ONLY = Data to be used only for the lAP (not for public release) 

LEGAL Identifies the legal sLatus of the flora in NSW (as listed in the NSW TSC Act 

STATUS TSCA 1995) 
1995 lB 	Schedule 1 Part I Endangered species 

IX = Schedule I Part 4 Species presumed extinct 
2V - Schedule 2 Vulnerable species 

CATEGORY The species category name used for the fauna point locality variable 
Records ending "_Mand." - For irreplaceable special sites which require 

preferential reservation 
Records ending "_Othcr" = For all other sites 

•1 
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Installation of WinERMS Database for Northern Study 
Area 

Installing the Northern Study Area Negotiation Database involves the following steps: 

copying the database files onto a computer with WInERMS installed 
directing W1nERMS to the database 
establishing the ODBC linkage between the WinERMS database and the attribute tables 
for fauna and flora point locality recoids (this is optional) 

Create a new directory for the W1nERMS database on your computer, and copy all supplied 
• 	 database files (including subdirectories) to this directory. You can name the directory 

whatever you like (e.g. rAP_NSA). 

Once the directory has been created and all files copied, the.database can be used by 
W1nERMS. Open WiJiERMS from within the Windows Program Manager, select BIlL then 
Open Database, Md a database, and Browse for the directory containing the database. Select 
this directory and then select the AREAJND file. QJ( your selection and Opcn the database. 
The database will now appear in the list of available databases whenever Open Database is 
selected. 

To establish an ODBC linkage between the WinERMS database and aibute tables for fauna 
• and flora point locality records, you need to already have ODEC drivers installed on your 
computer. If Microsoft Office is loaded then this facility should be available. The 
establishment of an ODBClinkage for the point locality data is optional. If you do not have 
ODBq capability you can still map point locality records but will not have access t.o the 
additional information stored in the attribute tables. From Program Manager, enter Contrl 
Lanri, and select ODBC. AN a new database, select 'Access Data' as a data source, entcr 
Fauna as the data source name and then Select Database. Set the database pathin the 'Select 
Database' window and then select QIC. For fauna this path must be set as tdataliapJauna.rndb 
beneath the directory containing the WinERMS Northern Study Area database. For example, 

Li if you loaded the WinERMS database into c:iaft_nsa then the path should specified as 

c: %iap_nsaklaialiapfaunamdb. 

This procedure needs to be repeated for the flor.a attribute table. The data. source name heeds 
to be Flora and the path set as tdataiapp1ant.mdb beneath the directory containing the 

• Northern Study Area database. 
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